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SS a l FOOD SAFETY AND STANDARDS

AUTHORITY OF INDIA

Inspiring Trust, Assuring Safe & Nutritious Food
Ministry of Health and Family Welfare, Government of India

[Participant ID

Participant Name

Test Center Name

Test Date 25/07/2019

Test Time 12:30 PM - 2:30 PM
Subject TECHNICAL OFFICER

Section : General Aptitude And Computer Literacy

QA1

Ans

15 31%er 1800 & Teag &1 HiT @1 e or?
v FEeER

X 2. TR

X 3. TUER

X4 afFEar

Question ID : 7230536896
Status : Answered
Chosen Option : 2

Ans

Q.2 37 ey 1 T FY S AW T ¥ 8% I TR ¥ T £ B R ¥ g0 | e |
FEaT
26 :649 ::34:7?

X 11221
v 2 1121
X 31024
7 41331

Question ID : 7230536892
Status : Answered
Chosen Option : 2

Ans

Q3 =7 fweT @ TS H A SW 9% F EF 3 THR T TEERG § O TR ¥ @ 9E T 9w §
T &

DEA: FFY : HGW :?

# 1. HHK
X2 ILL
v JJV
X 4 UK

Question ID : 7230536895
Status : Answered
Chosen Option : 3

Ans

https://cdn.digialm.com//per/g01/pub/1258/touchstone/AssessmentQPHTMLMode1//1258019125/1258019125S5D2135/1564215473273547/1...
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/12392 x 69
v2 7323 x 76
K 33223 x 63
< 46234 x 98

Question ID : 7230536893
Status : Not Answered
Chosen Option : --

Ans X 1. 2756
X 2 1404
X 3 2882
v 1441

3, 13, 61, 241, 721, 1441, ?

QS =g Fear F Tuw FY S e gEw guer § ved fE ¥ TUE ¥ 3eem|

Question ID : 7230536894

Not Attempted and
Marked For Review

Chosen Option : --

Status :

Ans X1_

v

r

Q.6 yogufy (Frr =1 e HAfEm, 1969 % @R, Tgufd o7 IRl F 390=y 7 g A = &
= T F=EE § @ Fiw @ Beew o g @7

ST FARTART GaRT T H1 TS & T A @ gad hal 1 Foel gl
X 2 ARy ganr wsgafy H Gl & o1 = &

HET oA 1 Jss ATty Isguia F Fdh F AdET = A E

e EeTeRar & df TSeuTad TUTAHST & Hrdl @ o Gl Hehd g

Question ID : 7230536900
Status : Answered
Chosen Option : 3

Ans 1. HEY THIST
v Bw gHsT
X 5 BT WHAT
X 4 AYST HHAET

Q7w o & FF I2 & A% 1839 F 9RT & FF WHST W IS F Fea g T

Question ID : 7230536897
Status : Answered
Chosen Option : 4

Ans X1_
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Q8 NASA = 2019 & e =R A YFSET X F T # o o
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X AR N i FFUT FRN SR T W I
X s e ol 3l F FROT TR FAT A1 Fer w@r o

Vi I gEF s Fav

Question ID : 7230536901
Status : Not Answered
Chosen Option : --

Q9 2015 & a1 ¥ 9IRE F FeT T AT T HF Tere' F FHA FT T 2
A o1 g St ST

X 2 @ET SEEEOT HR R 30g

X o U THERIOT e

(4.5'1’&'3-?\'{'@3?@'

Question ID : 7230536899
Status : Not Answered
Chosen Option : --

Q10 2000 ¥ EfRE & 0T Fooal & BFE AT F =T UEF SHar A?
Ans X 1. AT

X 2. Argersir
v 5 ARiedes
K4 R

Question ID : 7230536898
Status : Not Answered
Chosen Option : --

Q1 Select the most appropriate ANTONYM of the given word.

REPULSIVE
Ans X 1. obstinate
v 2. attractive
/< 3. assertive
< 4 offensive

Question ID : 7230536905
Status : Answered
Chosen Option : 2

Q12 gSelect the INCORRECTLY spelt word.

Ans

7< 1. hypocrisy
« 2. heriditory
#< 3. hindrance

#< 4 harass
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Question ID : 7230536906
Status : Not Answered
Chosen Option : --

https://cdn.digialm.com//per/g01/pub/1258/touchstone/AssessmentQPHTMLMode1//1258019125/1258019125S5D2135/15642154...

Q13 Select the most appropriate synonvm of the given word.
INGENIOUS
Ans (1. incompetent
< 2 awkward
/< 3. ignorant

W 4 resourceful

Question ID : 7230536904
Status : Answered
Chosen Option : 4

Q.14 The following sentence has been divided into four parts. One of the parts contains an error. Identify the part that has an
€LToL.

Only one / of the students / have submitted / the survey report.

Ans

7< 1. the survey report
/< 2. Only one

7< 3. of the students
+ 4. have submitted

Question ID : 7230536902
Status : Answered
Chosen Option : 3

Q.15 Select the option that can substitute the underlined part of the given sentence. If no substitution is needed, select ‘No
improvement required’.

The doctor said that he had been died from cholera.

Ans 3 1. has died from
v 2. had died of
#< 3. had been dead of
75 4. was dead by

Question ID : 7230536903
Status : Answered
Chosen Option : 4

Q.16 The allows users to perform the basic functions of a computer. It manages all software and peripheral hardware,
and accesses the central processing unit (CPU) for memory or storage purposes.

Ans

« 1. Operating System Software
/< 2. Application Software

/< 3. Utility Programs

/< 4. System Software

Question ID : 7230536907
Status : Answered
Chosen Option : 1
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Q17 FEFEwE 5E & HITF 55 F FIRT # FEfiE w9, 39 9 7 v e F sieeu &
FFAT &1 Bl 98 R, tFE W@ 3w FEEdl & qeud &g R w9 @ sl g

Ans \’1-W
X 2. I
X5 T O
}(4.34133?1?;?5{

Question ID : 7230536909
Status : Answered
Chosen Option : 1

Q18 What is common between Bing, DuckDuckGo and Google?
Ans o 1. These are search engines.
7% 2. They are applets

7< 3. They are web browsers.

/< 4. They are ISPs.

Question ID : 7230536911
Status : Answered
Chosen Option : 1

Q1 SrofafRe & @ #iF O RFeT & ScET/ERT FT Ue 3TAT HEROT FET 872
K e a3 sl T T S ge I wew o

&2
F@efr &Y 3ca¥ & W Fore = ¥ Uger e Sy |

X 3 UF TS, goUeT fawg Y@r & omATer
. Sl TERT T THATST AT

Question ID : 7230536915
Status : Answered
Chosen Option : 1

% F AEFaTe e TediE &
)BT A1 3T A2 & FA: 6 3T 4 ofde A B
i)Ter B1 3 B2 & e 3 3w 2 enféer g 7
iii)y AT A3 F = SAS1 + A2 HIeT & §
iv) T A3 & HigeT @ T B3 F & Eam S g
¥ B3 # weRiad 754 grem|

Ans X1 g
v 8
<36
X4 7

Question ID : 7230536912
Status : Answered
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l Chosen Option : 1 J

Q21 WWhich of the following statement is not true about Twitter?

Ans 1. People who follow you are called your followers.

52

The Twitter users followed by vou are the people or businesses whose updates you subscribe to.

&3

There is no limit to the number of accounts you can follow.

v

A request can be sent on twitter for other people to follow vou on Twitter.

Question ID : 7230536913
Status : Answered
Chosen Option : 2

Q22 To share a Google doc with others, click on:
Ans X 1. Edit > Share

#< 2. Tools > Share

< 3. View > Share

v 4. File > Share

Question ID : 7230536916
Status : Answered
Chosen Option : 4

Q23 For renaming a file in Windows, vou will most likely use:
Ans o 1. File Explorer

/< 2. File Manager

7% 3. File Directory

#< 4. File Folder

Question ID : 7230536908
Status : Answered

Chosen Option : 1

Q2 Crafafe # § B SOF/ET & ‘Fhd @ FASA I 9T ST T 32
Ans X1 REEYTE

v 2 g

X s BHGH

Ko e

Question ID : 7230536914
Status : Answered
Chosen Option : 1

Q25 Grefefea & ¥ Fi9 @1 ey, =g 9 # 9os = &g T HFeT ¢

Ans X 1. Ctrl+A
X 2. Ctrl+C
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v o Ctrl+B
X 4 Ctrl+X

Question ID : 7230536910
Status : Answered
Chosen Option : 3

Section : Functional Knowledge

%' NPOP & qof % #:
Ans x 1.
e yHTRT & T IS8T FE%HE (National Programme for Organic Processing)
&2
S 3caTel % AT IsET FAFA (National Programme for Organic Products)
Vs
Af3F oI F T =& FEFH (National Programme for Organic Production)
r
SfaF 3 ¥ BT Azer FIFF (Nodal Program for Organic Production)
Question ID : 7230536928
Status : Answered
Chosen Option : 3
Q.2

Ans 1. 1 April 1977
W 2. 1 April 1987
< 3.1 April 1952
< 4.1 April 1947

BIS is a statutory organization which came into existence on:

Question ID : 7230536927
Status : Answered
Chosen Option : 4

Q3 Fss wfafos % wER, Fo RO ol & G w o ¥ s e F @ afde

Ans <. FMET g
v 2 9T TRer g
X o areipd gU § AR @
X 4 ihr AT Renr # P

Question ID : 7230536917
Status : Answered
Chosen Option : 2

Q4 EIC is a certification body of India which ensures:
Ans 3¢ 1. Quality products exported within India.

/< 2. Quality and safety of products exported outside India.

/< 3. Safe products exported within India.
« 4 Quality and safety of products exported from India.
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Question ID : 7230536931
Status : Answered
Chosen Option : 4

Q5 oRay o W Faa 34 WaETant ganr &= Feel & ¥ 2N 9Sed §
Ans “ 1 h g

< 2. FSSAl

< 3. FSSA

X4 FeF F1E

Question ID : 7230536918
Status : Answered
Chosen Option : 2

Q6 International Organization for Standardization is:
Ans X 1. A Governmental organization

/< 2. A national organization

+ 3. A Non-governmental organization

/< 4. Dependent on government

Question ID : 7230536930
Status : Answered
Chosen Option : 3

Q7 The primary function of the Spices Board includes:

Ans o 1. Production and development of small and large cardamom
/< 2. Production and development of cloves
/< 3. Production and development of cinnamon

/< 4. Production and development of star anise

Question ID : 7230536938
Status : Answered
Chosen Option : 1

Q8 Agreement on Technical Barriers to Trade applies to:
Ans X 1. Only food products

/< 2. Phytosanitary measures

7< 3. Sanitary measures

« 4 All commodities, not just food

Question ID : 7230536940
Status : Answered
Chosen Option : 4

Q9 g g $ir aFteET F v RAfee sETEaET § T F @ 7 afde 2
Ans 1. FITEET FT S1ET
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v 2 e \rEeT $r gwor
< 3. Oiges g2
& 4 orguT Feelt AT

Question ID : 7230536921
Status : Answered
Chosen Option : 1

https://cdn.digialm.com//per/g01/pub/1258/touchstone/AssessmentQPHTMLMode1//1258019125/1258019125S5D2135/15642154...

Q.10 The Marine Products Export Development Authority is a statutery body functioning under the Department of:

Ans X 1. Social science

X 2. Arts

7% 3. Science

\f 4. Commerce

Question ID : 7230536934
Status : Answered
Chosen Option : 4

Q.11

Codex alimentarius standards are used by:

Ans x1_

Government to protect consumer’s health and ensure fair practices in the food trade

v

Codex members to protect consumer’s health and ensure fair practices in the food trade

X 3.

Members of public to protect health and ensure fair practices in the food trade

7% 4. Food manufacturers to promote food trade

Question ID : 7230536939
Status : Answered
Chosen Option : 2

Q12 According to the FSS Act, the full form of COA is:
Ans X 1. Certificate of Approval

7< 2. Certificate of Authority

« 3. Certificate of Analysis

/< 4. Certificate of Assessment

Question ID : 7230536923
Status : Answered
Chosen Option : 2

Q.13 Agricultural and Processed Food Products Export Development Authority has its headquarters at:

Ans  of 1. New Delhi
/< 2. Hyderabad
#< 3. Chennai
#< 4. Kochi

Question ID : 7230536935
Status : Answered
Chosen Option : 1

https://cdn.digialm.com//per/g01/pub/1258/touchstone/AssessmentQPHTMLMode1//1258019125/1258019125S5D2135/1564215473273547/1...

9/23

s@ Teachingninja.in



7/31/2019

https://cdn.digialm.com//per/g01/pub/1258/touchstone/AssessmentQPHTMLMode1//1258019125/1258019125S5D2135/15642154...

Ans

Q14 EIC Certification for food items like fish, meat, dairy and honey are:

/< 1. Not obligatory
+ 2. Mandatory
/< 3. Voluntary

/< 4. Optional

Question ID : 7230536933
Status : Answered
Chosen Option : 2

Ans

Q.15 Committee that evaluate food additives, contaminants, naturally occurring toxicants and residues of veterinary drugs in

food is called as:

v 1 JECFA
< 2. MRA
< 3. JEMRA
< 4 IMPR

Question ID : 7230536941
Status : Answered
Chosen Option : 3

Ans

Q16 Fss v, 2016  Fawager 3 AR, FBOs #F B off Farrew amst 1 gar fre R sy 5ot

# FT TARET F I FACT 5eE & w9 & 5 F B SR R e §) = s afee
]

v . mifesar g (Salvia hispanica)

X 2. grerafEasa FgEeEE (Polypodium leucotomos)
# 3. afweET (lpriflavone)
< 4 PABA

Question ID : 7230536929
Status : Answered
Chosen Option : 2

Ans

Q17 The logo found on an organic product is called:

' . Taivik Bharat
< 2. NPOP

75 3 LoQ

& 4 PGS-India

Question ID : 7230536925
Status : Answered
Chosen Option : 2

Ans

https://cdn.digialm.com//per/g01/pub/1258/touchstone/AssessmentQPHTMLMode1//1258019125/1258019125S5D2135/1564215473273547/...

Q.18 Pproduction development of small and large cardamom is the primary function of:

< 1. Coffee board

< 2. Cardamom board
+ 3. Rubber board

7< 4. Spice Board

[

]
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Question ID : 7230536937
Status : Answered
Chosen Option : 4

https://cdn.digialm.com//per/g01/pub/1258/touchstone/AssessmentQPHTMLMode1//1258019125/1258019125S5D2135/15642154...

Q1 rorrey sz W FSS Rftm, 2016 3 =Ereafse frmsr favy §2
A X aeEafae gEa e s

K2
e & g 39T sis (Specialty food containing plants)

v 3. mrEFRIfeE gerdr (Psychotropic substances)
X4 rdw Rt voee F e [

Question ID : 7230536922
Status : Answered
Chosen Option : 3

Q20 EIC is headed by the:

Ans 3 1. President
< 2. EIC council
+ 3 Chairman
#< 4. Director

Question ID : 7230536932
Status : Answered
Chosen Option : 3

Q.21 EiC g Bftew el S 5 moeh, sf, mw, T o e F R gem fee aw wEnr o e
e o mER F P

Ans X1 e

& 2 37 "y
V'3 AT

X+ wafeow

Question ID : 7230536936
Status : Answered
Chosen Option : 3

Q22 The vertical issues of FSS Act includes:
Ans X 1. Functional foods

< 2. Food Additives

o 3. Water, flavored water and beverages

/< 4. Genetically modified organisms and foods

Question ID : 7230536920
Status : Answered
Chosen Option : 2

Q.23 Fss fafmw, 2016 & wEivads & FFaN, FBOs &1 MR frar smer § fF & s & & semet &
A I o o oA ST GrEe 9 S

Ans X 1. anfésies (Artichoke)

https://cdn.digialm.com//per/g01/pub/1258/touchstone/AssessmentQPHTMLMode1//1258019125/1258019125S5D2135/1564215473273547/1...
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v R

2 3. 7irefr 1327 (Kale powder)
X 4 el TAEH

Question ID : 7230536926
Status : Answered
Chosen Option : 2

Q24 pss yrfdfews Fo oo & R | By e ¥ s w2 R
Ans 1 HATEH

X 2 g

v o BEl & TFe H FEEs A

K4 T e HR wiesa

Question ID : 7230536924
Status : Answered
Chosen Option : 3

OBy T & R W afaey § o o B 98 Seeer 7 e
Ans X 1 TqFT @

X 2 TR B

v 5 HEEA T

X 4 9I38Y

Question ID : 7230536919
Status : Answered
Chosen Option : 3

Q.26 ymnfaT ¥Fe g€ BET WY W oG H HA F FESH 955 30T FEH F F S FFEr I wewar ¥

Ans x1_
AT $i= % TT WA 6, 5 AT @ & @ Au a1 37 S0T F W WA OF 96y
AT

" )
A& Brwe 4ae & 98 H & Ny Fewt & o

X 3. 3T AaoT & Oy v ¥ et o Y
&4

HRET WEd AT X AAS ST F et AR AsEw F= F @Y SA0 9F I5gd Sl

Question ID : 7230536954
Status : Answered
Chosen Option : 4

Q27 ez grem wREwT MR TANH FHHAT F AT TR @ § § BEs B s mr 2
Ans X1 3= ABH I T TEET
X 2 T AU IIoq W SHIHT|

X 3 FET FEEE 9T W qI |
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v 4 WET T

Question ID : 7230536957
Status : Answered
Chosen Option : 1

https://cdn.digialm.com//per/g01/pub/1258/touchstone/AssessmentQPHTMLMode1//1258019125/1258019125S5D2135/15642154...

Q.28 As per the government regulations and recommendations, mandatory standards concerning the composition, quality,
inspection, and labeling of specific food products include:

Ans 1. ISO 22000:2005
/< 2. Standards of Grade
< 3. ISO 22000
« 4. Standards of Quality

Question ID : 7230536952
Status : Answered
Chosen Option : 3

Q.29 e "R TR TS ARG A @ A 8, S S U5 SR S # 0 94 9 §
T Fa FeleT HTE T T o

A X116 ®E, 2018
X 216 ST, 2018

< 316 A=, 2018
v ¢ 16 31&FaR, 2018

Question ID : 7230536959
Status : Answered
Chosen Option : 4

Q.30 @ffwrs e & T, @9 & #Y GO N7 TEY SEA 29T oS HT SUUNT FI:
ns X wfeErs

v 2 s

< 3. grerspTdr

X 4 HTEITF

Question ID : 7230536962
Status : Not Answered
Chosen Option : --

Q31 Vanaspati with added vitamin A can:

Ans 1. Be promoted using +F logo

/< 2. Be claimed as ‘fortified” or use +F logo for its promotion

v

Not be claimed as fortified” or use +F logo for its promotion
#< 4. Be claimed as ‘fortified’
Question ID : 7230536961
Status : Answered
Chosen Option : 1

Q.32

https://cdn.digialm.com//per/g01/pub/1258/touchstone/AssessmentQPHTMLMode1//1258019125/1258019125S5D2135/1564215473273547/...
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FMCG #T 90T &9 & g?
Ans  of 1.
Foe!l Tolal aTel 3USEFaT AT (Fast-moving consumer goods)
&2
%o T ATE Ui ¥ (Fruit and meat consumer grade)

&3
IS | Fgot e 39T ATl (Fast-moving customer goods)

r
WoT 3T AT 39seFar AATA (Fruit and meat consumer goods)

Chosen Option : 1

Question ID : 7230536950
Status : Answered

Q.33 g giéw S G sTeiwar S sad Riant & o W=, 39 SRR w@ S, weg aEa
TETeTeht & STSUH/TSERI0T THIUT T ST WTHATORT 3fE T ST &a7 &, F1 F47 Far 1T 27

Ans X 1. FoSCoRIS
X 2 FSS
X 3. FLRS

v ¢ 55 GIET Hede

Chosen Option : 2

Question ID : 7230536955
Status : Answered

Q.34 The high risk food business or the food business which require special attention include:

Ans " 1. Storage & Transport
7% 2. Manufacturing / Processing
/< 3. Catering
v 4 Milk & Milk Products

Chosen Option : 1

Question ID : 7230536966
Status : Answered

Q35 A fruit pulp is defined as:
Ans ( 1.

Edible part of the whole finit, which may be sliced or crushed but not reduced to a puree.
/< 2. Edible part of the whole fiuit which is pureed
X 3.

Edible part of the whole fiuit. which may be sliced or crushed or pureed
7% 4. Edible part of the whole fiuit

Chosen Option : --

Question ID : 7230536945
Status : Not Answered

Q36 \feat Food Products Order 1973 was promoted under the act:

Ans

https://cdn.digialm.com//per/g01/pub/1258/touchstone/AssessmentQPHTMLMode1//1258019125/125801912555D2135/1564215473273547/...  14/23
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< 1. Food Act

#< 2. Essential Service Maintenance Act
+ 3. Essential Commodities Act, 1955

/< 4. Consumer Protection Act, 1986

Question ID : 7230536949
Status : Answered
Chosen Option : 1

Q.37 Maharashtra Agro Industries Development Corporation Ltd promotes:

Ans x1.

Modernization of the Agro sector by inventing quality pesticides
/< 2. High quality fertilizers
/< 3. High quality seeds

« 4 Modernization of the Agro sector via mechanization

Question ID : 7230536951
Status : Answered
Chosen Option : 1

% FErw AGMARK SZieremeT #gr W B &
R e G

2 TR

X Ha%

X 4 FIeTRIar

Question ID : 7230536943
Status : Answered
Chosen Option : 3

% FoSCoRIS’ FT BaR =T 2
Ans ?{ 1.

Frafae e st 79 & FreTw & weg gIeT HEE (Food Safety Commission via Regular

Inspections and Sampling)
52
Frafag Biemr st 7o & areow & @eg w0 see (Food Survey Compliance via Regular

Inspections and Sampling)

W 3

Frafira frdreror ofit a9 & Arewd ¥ @R JIaT 3EIe (Food Safety Compliance through
Regular Inspections and Sampling)

&4

feafae e ot 77 & FeTw ¥ W G HEwadr (Food Safety conformity via Regular

Inspections and Sampling)

Question ID : 7230536953
Status : Not Answered
Chosen Option : --

Q40 Fss Rafermr, 2018 ¥ IR, AT F Y BEEES 75w &1 Tl F71 32

Ans
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X 1. wiftwEE F w F grEr R =T afed g
X 2. +F ST &7 3941 FT Head g
Vo +F S % e ¥ ge b

X+ BIEHEE 3T +F A9 FT 39T Far AT

Question ID : 7230536963
Status : Answered
Chosen Option : 2

Q.41

AGMARK T 90T &9 &7 7

Ane X1 R m& (Agricultural Mark)
W2

F¥ 39+ (FfEr 3w Bover) 3@F=F (Agriculural Produce (Grading and Marketing) Act)
X 3. & gATOT 97 (Agricultural Certificate)

X+ B s ARfATH (Agriculture Marking Act)

Question ID : 7230536942
Status : Answered

Chosen Option : 2

Q.42 ryr srm T, S &7 T s afRw @ oamer € % v zEer Som Rrmw aand g o
Ans X 1. TE=G R

V' 2. FEreAT IefT T FHE AT
7 3. AN ART ATET

X 4. ITSATT HARA Frefer

Question ID : 7230536958
Status : Answered
Chosen Option : 2

% FosTaC & qut 79 2 7

Ans K’ 1.
WIEA FI&T IRIET0T 3R 34T (Food Safety Training and Commission)

W 2
e FI&T FiRer AR FAUE (Food Safety Training and Certification)

53

TIed GI&T <Arar 3T 97U (Food Safety Trading and Certification)

r

ey JIaT MR 3T HTEET (Food Safety Trading and Commission)

Question ID : 7230536956
Status : Answered
Chosen Option : 2

Q.44 As per the government regulations and recommendations, voluntary standards concerning the composition, quality,

inspection, and labeling of specific food products include:
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Ans X 1. Standards of Quality

7< 2. Standards of Fill-of-Container
/< 3. Standards of Identity

o 4 Standards of Grade

Question ID : 7230536948
Status : Answered
Chosen Option : 1

Q.45 wwwmTH (SR iy sEfem ffmm, 2011 & sgEn, S99 @ 3@ WE @ e o Wi &
Ans X1_
e & N I T I TR SSHE HeT Y 75 U A @ew 7 Fhar §
W2
ST & oY A7 98T IT TS TEHH 6T T A5 THU THAT SU Wew 7ET S ehaT ¢
5 3.
arder % o I T T WEAT EUH HaT & Bl % a1 Wi & Wl 5 Tehall &

X 4 &rger F Ter 9T ASHE T Hha 2T

Question ID : 7230536944
Status : Answered
Chosen Option : 4

Q.46 gz Fam it A= HfOfEw, 2008 & FRTES F 97 W FE A 7 g a9 awe?
Ans q&T A % @EE

X2 fure mam & A

X o egafa & whE

v i\ AR TR % FeE

Question ID : 7230536946
Status : Answered
Chosen Option : 4

Q47 Special course in food safety training and certification programs is created for:

Ans X 1. State & Central Licensed food business
#< 2. Central Licensed food business.
/< 3. Food business
W 4

High risk food business or those businesses requiring special attention.

Question ID : 7230536960
Status : Answered
Chosen Option : 4

A48 FSSAIl garT RUCO & @i &7 & fow o] EEE 0=ty & 82
Ans x 1.
foreT gaae 9aTEIoT (Education Enforcement Environment)

&2
R8T I WitEufas g (Education Enforcement Ecological unit)
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53
e gaae oiftf2ufadr 9 (Edification Enforcement Ecosystem)
v
Rrer gage TR 99 (Education Enforcement Ecosystem)

Question ID : 7230536965
Status : Marked For Review
Chosen Option : 2

https://cdn.digialm.com//per/g01/pub/1258/touchstone/AssessmentQPHTMLMode1//1258019125/1258019125S5D2135/15642154...

Q49 The first city in India to be accorded the CSFH tag by FSSAI in 2008 is:
Ans 1. Delhi
7% 2. Mysore

v 3. Ahmedabad
/< 4. Bangalore

Question ID : 7230536964

Not Attempted and
Marked For Review

Chosen Option : --

Status :

Q.50 «)feat’ is defined as:
Ans X 1. Dried meat
75 2. Processed meat

« 3. Flesh and other edible parts of a carcass.
4 Cured meat

Question ID : 7230536947
Status : Answered
Chosen Option : 2

Q.51 The category of cholesterol which is also referred to as ‘good cholesterol” is:
Ans X 1. HDL:LDL

X 2 IDL

v 5. HDL

X 4 VLDL

Question ID : 7230536987
Status : Not Answered
Chosen Option : --

Q.52 Time ( in min) at specified temperature required to destroy 90% of the cells at the respective microbial population is
called as:

Ans X 1. Z-value
v 2. D-value
/< 3. F-value
< 4 T-value

Question ID : 7230536975
Status : Answered
Chosen Option : 2

Q.53
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e et F AT e T ofe 99 Yo7 F e w FeT TR S g1 WYaTr # 59 Tety @
FT T AT E?

K deE dfEE
X 2 g argraro
X3 3 ST
v+ ga (Pulsed) &egd &9

Question ID : 7230536981
Status : Answered
Chosen Option : 4

Q.54 fair fafarse aAE W, R o gam sha 1 Ffieet & St T #1 A & F B e
et $r Tear arTs 27

Ans X 1. T-ATS
X 2. D-AT
X 3. Z-ATe
v 4 F-Are

Question ID : 7230536985
Status : Answered
Chosen Option : 1

Q.55 Time of heating required to kill all vegetative cells of microorganisms is called:

Ans 3¢ 1. logarithmic order of death

7< 2. Kinetics of heat destruction
7< 3. Bacterial destruction rate
o 4 Thermal death time

Question ID : 7230536974
Status : Answered
Chosen Option : 4

Q.56 Pproteins that act like catalyst for some biochemical reaction is called as:
Ans & 1. Hormones

+ 2. Enzymes

#< 3. Proteins

/< 4. Lipids

Question ID : 7230536988
Status : Answered
Chosen Option : 4

Y srer AR (aw) oS Bee © TERE 2

Ans (11:“%3_“#”
X 2 AT
X3 ot Fr \mEr
x4-3'T|éE|T
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Question ID : 7230536967
Status : Answered
Chosen Option : 1

Ans « 1 Hli' Eﬁ' ﬂ,?f
X 2. @r AT BT (saccharin)

X 3 FHEdr arer
X4.E§m3ﬂ'w

% B grEEr F ak W e Reradr samr S 32

Question ID : 7230536991
Status : Answered
Chosen Option : 1

Ans X 1. Education and accomplishment

#< 2. Education and enforcement
« 3. Written programs and implementation

/< 4. Manual and accomplishment

Q.59 The two main components of GMPs essential for the success of the food safety system are:

Question ID : 7230536970
Status : Answered
Chosen Option : 2

Q60 The other name for ‘pre-requisite programs’ is:
Ans < 1. Written programs
/< 2. Implementation
X 3. HACCP

+ 4 Good Manufacturing Practices

Question ID : 7230536971
Status : Answered
Chosen Option : 2

Ans x1- H: %
v 2 =
X o grée
Ko gy

Q81 ofy o Tt 7 Foaaw TR e & ¥ FEF @ s BT S ¥

Question ID : 7230536984
Status : Answered
Chosen Option : 2

O a3 e W R i & ¥
Ans 1. STHAT
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< 2 o

v o TH FLAT
X 4. GG STATAT

Question ID : 7230536972
Status : Answered
Chosen Option : 4

O o Sy BT e
e o 3fE g Rafemme sa e ag

X2 ¥FER # WeR a7 s &g
X o feaeh w3 &g

K+ TF FA & A &g

Question ID : 7230536983
Status : Answered
Chosen Option : 3

Q64 Organic acids used in food preservation include:
Ans 5 1. Sulphuric acid

#< 2. Boric acid

/< 3. Hydrochloric acid

v 4. Sorbic acid

Question ID : 7230536977
Status : Answered
Chosen Option : 4

Q65 Thermobacteriology is a relationship between:

Ans X 1. Heat and virus
' 2. Heat and bacteria
/< 3. Heat and microorganisms

/< 4. Heat resistant bacteria and thermodynamics

Question ID : 7230536973
Status : Answered
Chosen Option : 2

Q66 Non-acidic foods have a pH range of:

Ans X' 1.5.3-4.6
X 2 4.6-3.7
K3 <37
v 4 7.0-5.3

Question ID : 7230536976
Status : Answered
Chosen Option : 4
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Q67 Rjsk for coronary heart disease may increase with high intakes of:

Ans X 1. Coconut oil
#< 2. Coconut
/< 3. Red palm oil
« 4 Animal fats

Question ID : 7230536986
Status : Answered
Chosen Option : 4

Q.68 Number of degrees required to pass through one log cyele is called as:
Ans  of 1. Z-value

< 2. D-value

#< 3. F-value

< 4 T-value

Question ID : 7230536980
Status : Not Answered
Chosen Option : --

Q.69 Ninimum water activity required for some yeasts and molds to grow is:
Ans (1. 1.00

v 2. 0.65

X 3. 1.50

X 4.2.00

Question ID : 7230536968
Status : Not Answered
Chosen Option : --

Q.70 The basic operational and environmental conditions applied to produce safe foods are called:
Ans 1. HACCP

X 2. FSSA

X 3. FSSAI

« 4 Good Manufacturing Practices

Question ID : 7230536969
Status : Answered
Chosen Option : 4

Q71 Cheddar cheese is manufactured using lipases extracted from:

Ans o 1. Aspergillus niger
/< 2. Lamb pre-gastric lipase
#< 3. Kid pre-gastric lipase

75 4. Penicillium camemberti

Question ID : 7230536990
Status : Answered
Chosen Option : 1
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7w $r Rewar & T onfae ¥

Ans X1_
FreTghes HETS ¥ TAET AT AR FEA R AW AR sgfEam enfarer @ #
X2 ofEs | 39Ra 9o9
&3
HFEAR R 7 HR Wer & e svwer e F= wf FEE F gww Fomg
W 4
agd Rt #R smeer e & @y fays, sga o= o

Question ID : 7230536978
Status : Answered
Chosen Option : 4

Q.73 === FEE W e, Aftes FEe 3t 93 F 9w F B # =S @ F9 S A g
A o

X 2 confEes

X 3 AfAAcy (Laminates)

X 4. vegfAfaaw Bl

Question ID : 7230536982
Status : Answered
Chosen Option : 3

Q.74 Two unsaturated fatty acids are also called as “essential fatty acids™ because:

Ans x 1.
They can be produced by the body as well as supplied from the diet.

" )

The body cannot produce therefore it becomes essential that we get them from the food we eat.

r 3

The body cannot produce in sufficient amounts therefore it should be supplied from the diet

7< 4. They are produced by the body

Question ID : 7230536979
Status : Answered
Chosen Option : 2

T FES §?

A X1 Teeemd (Cellulase)
v 2 TEFATCEE (Glucoamylases)
X 3. - ufFes
X4 - Tfies

Q.75 vemriEeE daEa A TeREE TN F EEReiw A, p-Te S = F v sefE e

Question ID : 7230536989
Status : Answered
Chosen Option : 3
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